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Welcome to Photoshop Elements

 

Welcome to Adobe

 

®

 

 Photoshop

 

®

 

 Elements, the complete end-to-end solution for anyone 
interested in digital photography. Photoshop Elements combines sophisticated function-
ality with ease of use to broaden the range of things you can do with your digital photo-
graphs. For instance, you can fix common flaws with the click of a button, enhance your 
photos with professional-looking effects, and transform your photos into works of art. 
In short, Photoshop Elements 3.0 helps you make your photos look their absolute best, 
whether your goal is a simple fix or an elaborate transformation.

This guide introduces you to the features and workspaces of Photoshop Elements and 
illustrates some of the capabilities it offers you. It doesn’t give detailed instructions on 
completing tasks in Photoshop Elements. As you start using the program, you can get 
detailed information and instructions by choosing Help > Photoshop Elements Help.

 

Working with your photos

 

Adobe Photoshop Elements brings the perfect combination of power and simplicity to 
digital imaging. Whether you use a digital camera or scan traditional photos, Photoshop 
Elements makes working with photos simple and fun. 

Here’s an overview of what you can do with Photoshop Elements 3.0.

 

Bring photos into your computer

 

You can bring photos into Photoshop Elements from your digital camera, scanner, photo 
CD, or memory stick. After they’re in Photoshop Elements, you can create folders to 
organize your photos and decide where each photo should be saved. For more infor-
mation, see Photoshop Elements Help.



 

2
Welcome to Photoshop Elements

 

You can easily acquire photos from almost any device.

 

Organize your photos 

 

In the File Browser, you can see the contents of all your photo folders, view detailed infor-
mation about any photo in any folder, and do general housekeeping: move photos into 
different folders, rename them, and so on. If you have a large number of photos, you can 
flag and sort photos for easy retrieval. For more information, see “A workspace for 
organizing” on page 13.

 

Enhance and transform your photos

 

One of the most compelling aspects of Photoshop Elements is the power, ease, and flexi-
bility of the tools it provides for fixing and transforming photos. 

Quick Fix is a centralized place for making a variety of color and lighting adjustments 
quickly. For more information, see “Editing and enhancing your photos” on page 17.
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This photo was fixed using Auto Color in Quick Fix, which gives you professional-looking results 
with just one click.

 

If you want more control, use the Standard Edit workspace. It has many of the same tools 
professional designers use. You can adjust color and lighting, fix flaws, and use layers, 
filters, gradients, and other powerful features to create sophisticated effects. For more 
information on Standard Edit, see “Editing and enhancing your photos” on page 17.

 

This composition was put together using layers in Standard Edit. Layers help your creativity take flight.
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Your creativity is not limited to single photos. Photoshop Elements has other ways to bring 
out the artist in you. For instance, you can create a panoramic view by stitching together 
several different photos of the same place or event. You’ll see many examples throughout 
this book.

 

Share your photos

 

After you perfect your photos, you may want to show them off to friends and family. 
Photoshop Elements helps you prepare your photos for e-mailing, printing at home, or 
distribution over the web. For more information, see “Sharing photos” on page 29 and 
Photoshop Elements Help.

 

Getting help

 

Photoshop Elements Help gives you detailed information on any topic in this book. Help 
is at your fingertips as you use the program, so that you can get your question answered 
and get back to your photos right away. To view the Help, choose Help > Photoshop 
Elements Help.

There are several ways to search for information. A quick way is to type a phrase in the 
Search box . If you prefer, you can browse through the topics in the 
Help Navigation pane or look in the index. As you work, Elements also displays Help links 
throughout the application that send you directly to the pertinent topic.

 

Camera Raw

 

Photoshop Elements 3.0 provides a new plug-in for editing digital photos in camera raw format. Many 
people like camera raw because it essentially preserves the camera image as a “negative,” or original, 
with minimum processing. The plug-in lets you open the camera raw image files directly in Photoshop 
Elements and edit them immediately. The available adjustments provide flexibility to produce the best 
image possible from a camera raw file.

In addition, the Camera Raw dialog box lets you save the settings for a specific camera or a specific light-
ing condition and reuse them when you open another camera raw file or a batch of camera raw files.
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Photoshop Elements Help has a new interface that delivers information quickly in the application window.

 

What’s new in Photoshop Elements 3.0?

 

16-bit image support

 

Provides functions for use with 16-bit images.

 

Noise removal capability

 

Corrects grainy areas of photos taken on camera phones or other low-
resolution devices.

 

Shadows/Highlights adjustment

 

Fixes exposure problems quickly and easily.

 

Styles and Effects palette

 

Contains over 100 customizable filters, effects, and layer styles.

 

Spot Healing Brush

 

Erases blemishes with a single click.

 

Red Eye tool

 

Returns eyes to a more natural color with one click.

 

Cookie Cutter tool

 

Crops photos in a predefined shape of your choosing.

 

Photo Bin

 

Displays every photo that is open in Standard Edit so that you can juggle multiple photos 
easily.

 

Improved File Browser

 

Supports flags that help you find and retrieve photos.
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A quick tour of Photoshop 
Elements 

 

Photoshop Elements 3.0 provides workspaces that give you a full-featured, end-to-end 
software solution for organizing and editing photos. This chapter introduces these 
workspaces.

 

A workspace for editing

 

You generally fix photos in either Standard Edit or Quick Fix. Standard Edit  is like a 
fully stocked photography studio. You can correct color problems, add a filter or a layer to 
create special effects, and use the many tools available for selecting portions of photos and 
enhancing photos. Quick Fix  contains a subset of those tools and commands, which 
fix the most common problems. For more information on editing photos, see “Editing 
and enhancing your photos” on page 17.

 

Note:

 

 In this book and in Help, Standard Edit is called simply the Editor.
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The Editor 

 

A.

 

 There are many tools for correcting problems and selecting portions of a photo.

 

B.

 

 The Photo Bin lets you 
see which photos are open in the Editor.

 

C.

 

 The Palette Bin holds palettes that you use to transform and 
enhance photos.

 

The Palette Bin

 

Palettes organize options, commands, and information so that you can work efficiently. 
When you first start Photoshop Elements, the Palette Bin contains three palettes: How To, 
Styles and Effects, and Layers. As you work with one of them, you can collapse the others 
to maximize the space available to that palette. When you work intensively with a palette, 
you may want to drag it out of the bin and onto the main workspace: Simply click the 
palette name and drag.

BA C 
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You can also customize the Palette Bin to suit your own work style and needs. For instance, 
you can add the Color Swatches palette to the bin simply by dragging it in by its tab. If you 
want to restore palettes to their original location in the Palette Bin, choose Window > 
Reset Palette Locations. For a list of palettes, see “Photoshop Elements palettes” on 
page 10.

 

The Palette Bin

 

A.

 

 The How To palette contains useful procedures, described step by step.

 

B.

 

 The Styles and Effects palette 
contains effects, filters, and layer styles.

 

C.

 

 You use the Layers palette to preserve your photo yet add 
enhancements in overlying layers. If you want to temporarily move the Palette Bin out of the way, simply 
click the gray button along the left pane, or drag the vertical bar to the right.

A

B

C
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Tools

 

You use the tools at the left edge of the Editor for many purposes. For instance, you use the 
Type tool  to add text, the Brush tool  to paint with color, the Spot Healing Brush  
to remove blemishes, the Clone Stamp tool  to copy an area of your photo, the Crop 
tool  to cut away excess area in a photo, and so on. To select a different tool, click its icon. 
To find out the name of a tool, position your pointer over it to view a tool tip. If you’d like 
to learn more, click the underlined words in the tool tip to see the Help topic that describes 
the tool.

 

Photoshop Elements palettes

 

In Photoshop Elements, palettes provide information on many aspects of your photos. You can also use 
some palettes to edit and enhance photos. To open a palette, select the palette’s name in the Windows 
menu. Open palettes have a checkmark next to their names. Here’s a list of the palettes you can use:

 

Color Swatches

 

Displays a list of colors for text, brushes, shapes, and so on.

 

Histogram

 

Displays color information, rendered as a graph, about a photo. See “Understanding his-
tograms” on page 38.

 

How To

 

Steps you through tasks that help you learn more about Photoshop Elements. You can click 
through all the categories to learn basic skills or advanced techniques.

 

Info

 

Displays the physical size of a photo. Also, you can view color information about the pixels under 
the pointer. As you move the pointer around in a photo, this color information is updated.

 

Layers

 

Shows you all the layers in a photo. In the Layers palette, you can show and hide layers, as well 
as link, merge, and flatten layers. See “Layers” on page 33.

 

Navigator

 

Shows you the area of a photo you’re viewing in the window. This is handy when you’re 
viewing a photo at a high magnification. To view another area, drag the red square in the palette to 
another part of the photo. 

 

Styles and Effects

 

Shows most of the filters, layer styles, and effects that you can apply to photos. 
See “Filters and layer styles” on page 40.

 

Undo History

 

Displays a list of all the changes made to a photo. You can undo this sequence one step 
at a time (in the same order that the change was applied) to undo the changes you’ve made.

If you inadvertently hide a palette and can’t locate it easily, you can restore the palettes to their original 
positions by selecting the name of the palette in the Windows menu. 
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Some tools in the Editor

 

A. 

 

The Hand tool repositions the photo in its window so that you can view other areas. 

 

B. 

 

The Eraser deletes pixels as you drag over them. 

 

C. 

 

The Move tool moves a selection into 
another area of a photo.

 

D. 

 

The Paint Bucket tool fills an area with color.

 

E. 

 

The Clone 
Stamp tool duplicates pixels.

 

F. 

 

The Brush tool deposits color on areas you drag over.

 

The options bar displays options for the selected tool. These options differ for each tool. 
For example, options for the Text tool include Font and Font Size, and options for the 
Brush tool include Brush Size and Paint Color. You can find out more about options for 
each tool in Help. For an overview of the selection tools, see “Selections” on page 38.

A B C

FED
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Tools make editing and enhancing your photos fun and easy.

 

A.

 

 The options bar displays settings you can customize to get the effect you want.

 

B.

 

 You can expand hidden tools by clicking the triangle in the lower right corner of a tool icon.

 

C.

 

 Shortcut key combinations help you select tools quickly.

A

C

B
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A workspace for organizing

 

Sometimes it’s hard to keep track of where digital photos live on your computer, especially 
when they end up in deeply nested subfolders. The File Browser displays the contents of 
all the folders on your computer so that you can find and view the photos you want. 

 

Entering values

 

When you’re working in Photoshop Elements, you can customize the behavior of tools or options by 
changing their values. You can enter or change settings in several ways, both in the options bar and in 
some dialog boxes and palettes. For instance, you can change the Opacity value in the Layers palette by 
dragging the slider or typing in the text box.

Drag a slider to the left or right.

Drag a dial clockwise or counter-clockwise.

To type in a text box, click in the box and then type. To apply your entry, press the Enter or Return key. 
You can also click in the text field and then use the arrow keys on the keyboard to change the value.
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The File Browser is a time-saver when you need to create new folders and move photos 
between folders. It displays detailed information about photos, including their file format, 
physical measurements, and file size. You can also sort photos in the File Browser and 
change the sort criteria. For more information on all of these features, see Photoshop 
Elements Help.

 

If you use digital photos in camera raw format, you can save time by applying camera 
raw settings to multiple photos at once in the File Browser. 

 

The File Browser

 

A.

 

 Menu bar.

 

B.

 

 The Folders palette displays the hierarchy of folders on your computer.

 

C.

 

 The Preview palette displays a resizable thumbnail of the selected photo.

 

D.

 

 The Metadata 
palette displays metadata categories that you can view and edit.

 

E.

 

 The toolbar gives you quick 
access to frequently used tools.  

 

F.

 

 The location bar displays the name and path of the open folder.

 

G.

 

 The main window displays the contents of a folder.

 

H.

 

 The selected file is highlighted.

 

Flagging files

 

Want a quick way to get back to photos that you really liked, or needed to fix? In the File 
Browser you can flag photos, then get back to them with a single click. From the View menu 
in the File Browser, you can choose to view only flagged photos or only unflagged photos.

A

F

H

B

C

D

G

E



 

15

 

ADOBE PHOTOSHOP ELEMENTS 3.0

 

Getting Started Guide

 

Flag any photo that you want to find quickly.

 

Sorting photos with the File Browser

 

You can use the File Browser to sort photos in several different ways. For example, you can 
choose Date Modified from the sort menu to make sure that you’re opening the most 
current version of a photo.

 

To make sorting more powerful, try sorting just flagged or unflagged photos to narrow 
your search.

 

Adding keywords to photos

 

In the File Browser, the Keyword palette lets you create and apply keywords to photos. 
Using keywords, you can group files together by their content, then use the keywords to 
find and view groups of files. To add a keyword to a photo, simply select the file and, in the 
Keywords palette, double-click the keyword you want to add. 

You can create as many keywords as you require to organize your photos. You can also 
create a group of keywords that you frequently use and apply them as a group. Keywords 
are organized in sets called categories. You can recategorize keywords if you need to.
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File Browser Keywords palette

 

A.

 

 Expand a keyword group to view the individual keywords.

 

B.

 

 Keywords are displayed in categories.

 

C.

 

 Selected keyword is 
highlighted for easy identification.

 

D.

 

 Click to show/hide content 
of keyword group.

 

E.

 

 Groups with one or more keywords applied 
are marked with a dash.

 

F.

 

 Applied keywords are marked with a check.

 

Starting creations from the File Browser 

 

You can start creations right from the File Browser. For instance, you can begin making a 
Photomerge panorama directly in the File Browser. Just select the photos you want to 
include, and with a few clicks, Photomerge stitches them together into one panoramic 
image.

 

You can create a panoramic image directly from the File Browser.

A

B

D
C

E

F
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Editing and enhancing your 
photos

 

Even good photos need a little help sometimes. This chapter illustrates how. Using 
Photoshop Elements, you can correct lighting and color problems, reduce fuzziness and 
noise, remove red eyes and other flaws, and crop to improve composition, quickly and 
intuitively. 

Photoshop Elements has two workspaces for editing photos: Standard Edit  and 
Quick Fix .

 

Standard Edit (the Editor) 

 

Provides a comprehensive set of hands-on tools and 
commands for editing and enhancing your photos. As you use the Editor, you will gain 
confidence in your ability to make your photos look their best. For a quick tour of its 
components, see “A workspace for editing” on page 7.

 

Quick Fix 

 

Uses a few powerful commands that take just one click. Quick Fix is the place 
to go when you want ease and convenience. You can always undo changes you’ve made by 
clicking the Reset button, so you can freely experiment with the available fixes. 

 

Click a workspace icon to go to that workspace.
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Lighting problems

 

Too much light, or too little; washed-out or murky: These problems can be due to poor 
lighting where you took your photo, problems with your digital camera, or scanner 
problems. You can make lighting fixes in either Quick Fix or the Editor.

 

This photo is much too dark, making the colors look muddy.

 

In Quick Fix, use Smart Fix for the simplest lighting fix. Smart Fix does an instant analysis 
of over-and underexposed areas and adjusts them automatically. It also addresses contrast 
and saturation problems. You can fix shadows and highlights in Quick Fix by dragging the 
Lighten Shadows or Darken Highlights sliders.

 

Smart Fix provides an instantaneous fix.
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In the Editor, you can use the Levels command to correct lighting problems. Levels uses 
three adjustment sliders that control how the darkest pixels, mid-tone pixels, and lightest 
pixels look. To correct an underexposed photo, for example, you can drag the Dark slider 
to the right. Levels displays a histogram to help you diagnose problems in your photos. 
For more information on histograms, see “Understanding histograms” on page 38.

 

In the Editor, the Levels command displays a histogram that diagnoses lighting problems. 

 

You can also use a Levels adjustment layer to correct lighting. For more information, 
see “Adjustment layers” on page 36.

 

The Editor offers many other ways to fix lighting problems. Here are some examples:

 

•

 

The Screen blending mode lightens dark photos (see “Blending modes” on page 41).

 

•

 

The Shadow/Highlights command (Enhance > Adjust Lighting > Shadow/Highlights) 
brings out shadowed parts of your image or darkens overly bright areas. 

 

•

 

The Brightness/Contrast command (Enhance > Adjust Lighting > 
Brightness/Contrast) has a Brightness slider you can drag to lighten or darken a photo.

 

For more information on these commands, see Photoshop Elements Help.
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Color problems

 

There are many kinds of color problems: skewed colors due to incorrect camera settings, 
lifeless colors in old photos, faded colors due to lack of contrast, and more. Both Quick Fix 
and the Editor have tools that target color problems.

In Quick Fix, use Auto Color to instantly correct color. You can fine-tune the results using 
the Hue, Temperature, and Tint sliders. At any time, you can click the Reset button to 
return your photo to its original settings.

 

Auto Color wakes up the colors of the sunflowers in this photo.

 

When you want more control, you can use the sophisticated set of color-correction 
features in the Editor. If you’re new to color correction, you can use Color Variations 
(Enhance > Adjust Color > Color Variations) in the Editor to experiment with different 
fixes, seeing the effect of each before you save your photo.
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The Variations command shows how different color settings look applied to your photo so that you 
can choose the right fix.

 

In the Editor, you can also use the Hue/Saturation command (Enhance > Adjust Color > 
Hue/Saturation). Drag the Hue and Saturation sliders to bring colors back to life. For 
more information, see Photoshop Elements Help.
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Fuzziness and noise

 

You can fix fuzziness using either the Editor or Quick Fix. In the Editor, you can use filters 
to fix both fuzziness and noise. In Quick Fix, sharpening a photo is as easy as clicking a 
button.

 

Sharpening photos

 

Either someone moved just as you snapped the photo, the flash didn’t 
fire, or the camera battery was running low. But the result is the same: A fuzzy photo. Luckily, 
you can sharpen fuzzy photos in two ways. The Unsharp Mask filter in the Editor sharpens 
contrast among areas of different colors. Or you can use the Sharpen tool  to sharpen areas 
by clicking and dragging. In Quick Fix, Auto Sharpen does much the same thing. 

 

Removing color casts

 

Knowing how to correct color casts is especially useful if you use scanners, which sometimes add a blue 
or green tone to photos. The Remove Color Cast command (Enhance > Adjust Color > Remove Color 
Cast), available from the Editor, removes the cast after you click in an area of a photo that should be pure 
white or pure black. Photoshop Elements automatically neutralizes color values in the clicked area and 
applies that change to all the pixels in the photo. You can also correct a color cast by using a Levels 
adjustment layer to fix each color channel. (See “Adjustment layers” on page 36.)

 

 

 

The Remove Color Cast command fixes your photo with just a few clicks. You can apply this
command a few times if necessary.
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The Unsharp Mask filter adds contrast to reduce fuzziness.

 

Removing noise

 

“Noisy” digital photos have grainy areas or out-of-place pixels caused by 
low light levels. Noise also occurs in low-resolution photos, such as photos taken on a 
camera-enabled wireless phone. For example, a picture taken in a dark room may have a 
few bright blue pixels in light areas. Using the Reduce Noise filter, you can smooth away 
these stray pixels. The Reduce Noise filter is also useful for correcting photos with too 
much contrast, which can give photos a grainy look.

 

In this photo, taken with a wireless phone, there is some noise in the 
boy’s face. The Reduce Noise filter smooths away the stray pixels.
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Flaws, blemishes, and composition problems

 

Photoshop Elements has many tools for repairing flaws in your photos. Among these are 
the Red Eye tool  for removing red eyes, the Spot Healing Brush tool  for eliminating 
small blemishes, and the Healing Brush tool  for smoothing away larger problem areas. 

And sometimes a mediocre photo imprisons a great one. You can use the Crop tool  to 
remove nonessential areas of a photo, focusing attention on your subject and improving 
the composition.

 

Fixing red eyes

 

This might be the most common problem of all: ghoulish red eyes. The Red Eye tool, 
available in both Quick Fix and the Editor, restores a more natural color. To use the tool, 
you can either click once in an eye, or drag the tool around an eye. You can drag the Pupil 
size slider to enlarge or decrease the central black pupil as needed to make it look natural. 
The Darken Amount slider ensures that the replacement eye color is true to life.

 

Photoshop Elements knows what color eyes are supposed to be.

 

Removing flaws

 

Many otherwise good photos are spoiled by unflattering flaws. The Spot Healing Brush 
tool  and the Healing Brush tool  blend away these distracting imperfections. They 
work by matching the underlying texture and color of a desirable portion of a photo. The 
tools blend the healing color for a seamless, professional look.
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The Healing Brush tool  works best in larger areas. For example, to correct red, ruddy 
cheeks with the Healing Brush tool, Alt-click in the non-red forehead region and then drag 
the Healing Brush over the cheeks.

The Spot Healing Brush tool  repairs small areas, such as blemishes. Simply select the 
tool and click once over the area. You can change the size of the brush tip in the options 
bar if needed. You can also drag to highlight a portion of a photo that you want to repair, 
such as crows’ feet at the corner of the eyes. The Spot Healing Brush can remove larger 
flaws, but it works best when the surrounding area is uniform in texture and color. 

 

Removing this blemish just takes one click with the Spot Healing Brush.

 

Photoshop Elements has a few other tools you can use to eliminate flaws. Try using the 
Clone Stamp tool  to duplicate good areas of a photo over other areas. The Blur tool  
can make blemishes less noticeable. For more information about these and other tools, 
see Photoshop Elements Help.

 

Cropping photos

 

Cropping means removing part of a photo to focus attention on a subject. The Crop 
tool  makes it easy: Just drag a border around the part of your photo you want to keep, 
click the Commit button , and you’re done. You’ll find the Crop tool both in Quick 
Fix  and in the Editor .
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Cropping focuses attention on the young girl and improves the overall composition.

 

Automatically cropping scanned photos

 

The Divide Scanned Photos command is a time-saver if you scan a lot of photos. It does all the work of 
straightening, cropping, and dividing for you. Here’s how it works:

When you scan in more than one photo, Divide Scanned Photos automatically senses the edges of each 
photo. It then straightens the photo edges, crops each photo individually, and puts each into its own file.

Divide Scanned Photos works best when there isn’t a lot of white at the edges of the photo, as in pictures 
of snow scenes or very light skies. To ensure that your photos are divided correctly, place a brightly 
colored piece of paper on top of them in your scanner. This helps Photoshop Elements sense where the 
edges of the photos lie.



 

27

 

ADOBE PHOTOSHOP ELEMENTS 3.0

 

Getting Started Guide

 

Saving your work

 

After you edit an image in the Editor, you need to save it. Usually you’ll want to save an 
image that you are editing in the Photoshop (PSD) format to ensure that all the image data 
is preserved. When you want to share a photo, or if you want to create a smaller photo file, 
you can save the image in another format.

 

Photoshop Elements file formats

 

Some people are confused by file formats and have trouble deciding what format to use when 
working in and saving files. Photoshop Elements 3.0 supports several kinds of digital photo file formats. 
The following list gives some tips on using each format. For more information on file formats, 
see Photoshop Elements Help.

 

JPEG

 

JPEG is a common format for photos that are exchanged in e-mail or displayed on a web page. 
JPEG files can be compressed to a very small size.

 

PSD

 

PSD is Photoshop Element’s native file format. Saving a photo as a PSD file ensures that you retain 
important data, such as layer information. However, other applications may not be able to use PSD files, 
and they tend to be large. So, it’s a good idea to convert to JPEG when you want to share your photo.

 

PDF

 

PDF files can be read by anyone using the free Adobe Acrobat

 

®

 

 Reader. Because PDF works on 
every platform, it’s a good format for distributing photos to a wide audience.

 

GIF

 

GIF files are small, because of the limited number of colors that this format supports. GIF is best for 
images made up primarily of line art, text, and large areas of color rather than photos. GIF is a must for 
web animations. 

 

TIFF

 

TIFF is a common file format that can be used in many photo-editing applications. TIFFs are good 
if recipients like to print photos on a home printer.

 

PNG

 

PNG is another format that is optimized for web display. PNG-8 is an alternative to GIF (for line art 
and text), and PNG-24 is an alternative to JPEG (for photos).
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Sharing photos

 

After you fix your photos, get ready to show them off. Photoshop Elements lets you share 
your photos with family, friends, and colleagues through e-mail, over the web, or in 
printed copies. You can even create slide shows with music and customized transitions. 

 

E-mailing photos

 

It couldn’t be simpler to share your photos through e-mail. Photoshop Elements leads you 
through the process in a few easy steps.  After you choose a photo, Photoshop Elements 
automatically helps you resize the photo for e-mailing and lets you change its file format 
so that the photo is optimized for e-mail delivery. 

 

Sharing photos online

 

Use the Save For Web command to optimize your photos for web display and see how they 
would look in different file formats with different settings applied. You can even preview 
your photos in a web browser before you finalize the settings. You can also create an entire 
web photo gallery of your photos. Photoshop Elements provides templates that make your 
photos look their best on the web. 
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The photo on the left is the original. The one on the right is a preview that shows how the photo 
would appear on the web. As you experiment with different optimization settings, the photo 
on the right changes to reflect the new settings. Here, JPEG, the usual format for photographs, 
is being chosen.

 

Printing photos

 

When you have a great digital photo, it’s natural to want a printed, tangible copy. If you 
have a color printer, Photoshop Elements makes it easy to print copies of your favorite 
photos. You can print one photo per page, or print a picture package with one or more 
photos at several different sizes per page.  

If you intend to print a photo, you should keep the photo file at its most robust size. This 
ensures that you get a good quality printout that preserves details, and that you can print the 
photo at larger sizes. It’s more challenging to print good copies of small or low-resolution 
photos. But printed at a smaller size, even lower-quality digital photos can look good.
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A common problem in printed digital photos is color shift: The colors in the printed copy 
don’t match the colors on the screen. As you move a photo from your camera or scanner 
to your monitor, and finally to a printer, the colors shift because each device handles color 
differently. Photoshop Elements has the color-management tools you need to make screen 
colors match print colors.

Color-management tools help prevent color shift as images move from device to device.

Using color management

For color management to work, you need to profile your devices or use an ICC profile created by the 
manufacturer. Profiling isn’t always necessary for digital cameras or scanners. However, profiling and 
calibrating your monitor is critical. You can use Adobe Gamma software on Windows or the Apple 
Display Calibrator Assistant on Mac OS. Adobe Gamma is included with your Photoshop Elements 
software. Many printer manufacturers provide ICC printer profiles on their web sites.

When you work on a photo and save it, you can have Photoshop Elements embed an ICC profile that 
reflects the colors you saw on your computer monitor. If you send the photo to your inkjet printer, the 
color-management system reads the embedded profile and translates the color data using the printer’s 
profile. It’s important to install your printer’s profile from the manufacturer (see Photoshop Elements 
Help for more information). Your printer can then use the translated color data to more accurately print 
the colors that you saw on your monitor.
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Photoshop Elements contains an artist’s studio that’s fully stocked with everything you’ll 
need to manipulate and transform your photos. This chapter introduces you to some of 
the more exciting and powerful of these editing features:

• You can superimpose layers over your original photo to enhance and edit it in many 
ways, keeping the original intact. Opacity settings determine the degree to which a layer 
obscures or reveals the layers below it. Text and shapes are automatically added in new 
layers, preserving the underlying Background layer.

• Selections let you work with portions of a photo. Select the portions of the photo or 
pixels you want to work with, and manipulate them in any way, either in a layer or in 
the original. For example, if a person’s face is in shadow but the rest of the photo is fine, 
you can select the face and lighten it separately from the rest of the photo.

• Filters let you change the look of a photo. For instance, you can make a photo look like 
a mosaic or an impressionistic painting, and you can add special lighting or distortions. 
Photoshop Elements also supplies a variety of effects, such as shadows, glows, and 
strokes. Layer styles are especially useful with text applied in a layer. For instance, you 
can apply a drop shadow style or a bevel style to make the text stand out.

• Blending modes are used in the Layers palette and with certain tools. In the Layers 
palette, you can lighten or darken a photo, or add effects with different blending modes. 
When used with painting and editing tools, blending modes determine how pixels in a 
layer are affected by those tools.

• Gradients add a mix of color or transparency to your photos and artwork. You can use 
ready-made mixes or make your own.

Layers
Think of layers as pieces of glass stacked up in a pile. In the stack of glass, some pieces 
might be colored, some opaque, and some clear. You can take out the opaque pieces, move 
the colored pieces, paint on any piece, and rearrange the stack any way you’d like. Photo 
layers work in much the same way but offer far more flexibility. You can work on each layer 
independently, experimenting to create the effect you want. When you are satisfied with 
your enhancements, you have the option of merging the layers. 
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It’s important to work in a file format that preserves layers. Save your permanent files in PSD 
file format; other file formats may not support layers (see “Photoshop Elements file formats” 
on page 27.) However, keep in mind that layers increase the file size of a photo. So, when you 
share your photos, save a copy of the photo file in JPEG format, which eliminates the layers 
to create a smaller file. Your original source PSD file with the layers remains intact.

To learn more about layers, see Photoshop Elements Help.

The Background layer, the base in the stack of layers, usually contains the photo image data. 
The Background layer does not support transparency and is locked to protect your photo. 
However, you can convert the Background layer to a normal layer by double-clicking it 
in the Layers palette. Your editing commands affect only the active layer. Here, the Background 
is the active layer (blue shading).

All the layers in a photo appear in the Layers palette, which you can expand and drag out 
of the Palette Bin. It’s a good idea to check which layer is active, to make sure that you’re 
working in the right one. In the Layers palette, the active layer is the one with blue shading.
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Most layers contain images, and so they are called image layers. But there are some other 
special layer types.

Text and shape layers

To add text or a shape to a photo, you select a text tool or a shape tool and click in the 
photo to begin typing or drawing a shape. As soon as you do, Photoshop Elements 
automatically adds a type or shape layer to the Layers palette. If it weren’t for text layers, 
you would permanently destroy part of a photo by adding text, obliterating the pixels 
directly below it. Layers preserve all the information in the photo, giving you maximum 
flexibility.

The talk bubble and the text are in their own layers to protect the underlying photo.

Fill layers 

You can use fill layers to fill a layer with a solid color, a pattern, or a gradient. As with 
ordinary image layers, you can change the opacity and blending mode of fill layers. There 
are several patterns or gradients you can choose from, or you can create your own. 
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This fill layer simulates the appearance of rain. You can reduce the opacity of fill layers, allowing 
more of the photo to show through, as in this example.

Adjustment layers

Adjustment layers let you adjust color tones and experiment with effects without harming 
any image data. You can think of an adjustment layer as a colored or corrective veil 
affecting the layers below it. When you are happy with the result of an adjustment layer, 
you have the option of merging it into the layers below. Unless you decide to merge, 
adjustment layers are nondestructive: You see the underlying photo pixels through the 
adjustment, but the pixel values are not changed. You can continue to make changes until 
you’re happy with the adjustment.

Adjustment layers fall into two broad categories: those used to make corrections, and 
those used to create effects.

An example of a corrective adjustment is Levels. When you create a Levels adjustment 
layer, Photoshop Elements displays a histogram that lets you analyze and correct 
lighting problems.
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As the histogram on the left shows, this photo is too dark. Dragging the slider to the left lightens the photo.

An example of an adjustment that creates an effect is Posterize. You can use Posterize to 
turn your photo into a piece of pop art. The following illustration shows some other 
adjustments.

The photo on the far left is the original. In the photos to the right, you can see the effect of applying the Posterize, 
Invert, and Hue/Saturation adjustment layers.
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Selections
Suppose that, in your favorite shot of your best friend, a stranger’s elbow juts out from the 
left edge of the photo. Or suppose you want to superimpose your pet against the 
background of a tropical beach. Using Photoshop Elements selection tools, you can isolate 
just the area you want to work with while protecting the rest of the photo. For example, to 
remove the stranger’s elbow, you’d first have to select the pixels that make up that elbow. 
You can’t work on that area until you have selected it.

Understanding histograms

The histogram is a valuable but underused tool for diagnosing and correcting color problems. A histo-
gram displays a graph showing the range of colors in your photo. Dark pixels are represented on the far 
left side of the graph, while the lightest colors are on the right. Ideally, you want a nice balance between 
the darkest and lightest areas. A photo with good color produces a histogram that slopes up at both 
ends, which means that the photo has good detail in both shadows and highlights. A photo that’s too 
dark produces a histogram with a sharp cliff on the left side. A photo that’s too light produces a histo-
gram with a cliff on the right.

The underexposed photo of the chipmunk has a histogram with a wide gap at the right, indicating the 
absence of light pixels. The overexposed photo of the girl has a histogram with a gap at the left, indicating 
the absence of dark pixels. To correct photos like these, you can use Smart Fix in Quick Fix or a Levels 
adjustment layer in the Editor.
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Photoshop Elements offers a variety of special purpose selection tools, for instance, tools 
for selecting large areas of similar color, selecting round or square objects, and selecting 
objects with complicated, irregular borders. After you select a portion of a photo, you can 
copy and paste the selection into another layer, another photo, or a new blank image.

Selections are especially useful when a particular area of a photo needs color correction or 
enhancement. For example, you can apply the Levels command to a selection or apply a 
filter or gradient. Like photos, selections can be skewed, rotated, and transformed.

Each selection tool works a bit differently, giving you the flexibility you need to make different kinds of 
selections.
A. The Rectangle Marquee tool makes rectangular selections. B. The Elliptical Marquee tool is useful for 
selecting shapes like the round inner tube. C. The Magic Wand tool selects large areas of uniform color, like the 
blue sky shown here, with one click. D. The Selection Brush tool, which has many brush size and brush tip 
options, lets you paint over an area to create a selection. E. The Lasso tool makes freeform selections as you click 
and drag around an object. F. The Polygonal Lasso tool draws straight segments around an object as you 
click. G. The Magnetic Lasso tool snaps to the edge of an object as you drag around it, creating complicated 
selection borders with little effort.

A B

C D

E F G
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Filters and layer styles
Turning your photographic masterpiece into an artistic masterpiece is easy when you use 
Photoshop Elements filters and layer styles. 

Filters let you change the overall look of a photo. For instance, you can turn a photo into 
a patchwork quilt, a chalk and charcoal drawing, a stained glass window, or even a needle-
point template. The filter thumbnails in the Styles and Effects palette give you an idea of 
the effect each filter will have. You can apply some filters cumulatively, creating a unique 
custom effect.

Filters can radically change the mood of a photo or image.

Layer styles let you quickly apply effects to an entire layer. Like filters, layer styles are 
available from the Styles and Effects palette, which displays a thumbnail showing the look 
of each style. Along with many other looks, you can add a metallic sheen, a fiery cloud, or 
a neon glow using layer styles. They are especially effective when applied to text added to 
a photo or image. You can use the layer style, along with the font, to reinforce the meaning 
of the text in the text layer. For example, you can use one of the many drop shadow styles 
to create a three-dimensional, embossed, or starkly elegant look.
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The text in these photos gives a tropical feel. The layer styles draw attention to the text. 

Blending modes
You can apply blending modes both in the Layers palette and with certain editing tools. 
Their use is slightly different depending on where you apply the mode. 

When used with layers, blending modes control how pixels in one layer blend with pixels 
in another. In the Layers palette, you can use blending modes for color correction or for 
effects. For example, you can darken a photo by using the Multiply mode and lighten it by 
using the Screen blending mode. You can use blending modes in conjunction with other 
fixes, such as adjustment layers. Although you can’t apply blending modes to the 
Background layer in a photo, you can convert a Background layer to a regular layer by 
double-clicking it and renaming it Layer 0.
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The Multiply blending mode (left), Screen blending mode (center), and Luminosity blending mode (right) 
applied to the layer with the starfish.

When used with painting and editing tools, blending modes determine how pixels in an 
image are affected by those tools. For instance, when you paint with the Brush tool, the 
Normal blending mode is selected in the options bar by default. In Normal mode, the base 
color (the color being painted over) is painted with the blend color (the color being applied). 
The result is a blend of these two colors. But you can select another blending mode to change 
the way color is added to a photo. For example, if you select the Hard Light blending mode, 
you create an effect similar to shining a harsh spotlight on the image. 

For more information, see the list of blending modes in Photoshop Elements Help.
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The Color blending mode combines the base color (in the example above, the white color 
of the house) and the hue of the color painted over the base (the vivid red color). The Color 
blending mode also preserves the gray levels in the photo, allowing you to tint the photo.

Gradients
Gradients add a mix of color or transparency to your photos. Photoshop Elements 
provides a number of ready-made gradients that you can add to your photo using the 
Gradient tool . You can apply gradients to a selection or to an entire photo, depending 
on where you draw the gradient. You can even apply a gradient to grayscale photos.

When you’re using the Gradient tool, the options bar gives you several choices for the way 
a gradient is drawn. You can add gradients in shapes like circles or diamonds. With the 
Gradient Editor, you can customize existing gradients, or create one of your own. 
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Using the Gradient Editor, you can create a custom mix of colors in your photos. 
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